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Software License

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE”) CAREFULLY BEFORE USING MAGICSCROLL. BY USING THIS 
SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, 
DO NOT INSTALL AND/OR USE MAGICSCROLL AND, IF PRESENTED WITH THE OPTION TO “AGREE” OR “DISAGREE” TO THE TERMS, CLICK 
“DISAGREE”.

IMPORTANT NOTE: To the extent that this software may be used to reproduce, modify, publish and distribute materials, it is licensed to you only 
for reproduction, modification, publication and distribution of non-copyrighted materials, materials in which you own the copyright, or materials 
you are authorized or legally permitted to reproduce, modify, publish or distribute. If you are uncertain about your right to copy, modify, publish or 
distribute any material, you should contact your legal advisor.

1. General. 
A. MAGICSCROLL, any third party software, documentation, interfaces, content, fonts and any data accompanying this License on disk, in read only 
memory, on any other media or in any other form (collectively the “Apple Software”) are licensed, not sold, to you by Apple Inc. (“Apple”) for use only 
under the terms of this License. Magic Teleprompting, Inc retains ownership of the MagicScroll itself and reserve all rights not expressly granted to 
you. 

B. Magic Teleprompting, at its discretion, may make available future upgrades or updates to MagicScroll for your Apple-branded computer. Magic 
Teleprompting may provide you any such upgrades and updates that it may release up to, but not including, the next major release of MagicScroll, 
for free. After the next major release of MagicScroll, Magic Teleprompting may also at its discretion continue to provide minor upgrades and updates 
to MagicScroll. Upgrades and updates, if any, may not necessarily include all existing software features or new features that Magic Teleprompting 
releases for newer models of Apple-branded computers and may, at Magic Teleprompting’s discretion, be provided with or without charge. The 
terms of this License will govern any software upgrades or updates provided by Magic Teleprompting to the original Magic Teleprompting Software 
product, unless such upgrade or update is accompanied by a separate license in which case you agree that the terms of that license will govern such 
upgrade or update. 

2. Permitted License Uses and Restrictions. 
A. License. Subject to the terms and conditions of this License, unless you obtained MagicScroll as described in Section 2B, you have the right to use 
MagicScroll as permitted by the Mac App Store Product Usage Rules set forth in the App Store Terms and Conditions (http://www.apple.com/legal/
itunes/ww/) (“Usage Rules”), and are granted a limited, non-transferable, non-exclusive license:

(i) to download, install, use and run for personal, non-commercial use, one (1) copy of MagicScroll directly on each Apple-branded computer run-
ning OS X (“Mac Computer”) that you own or control; and

(ii) if you are a commercial enterprise or educational institution, to download, install, use and run one (1) copy of MagicScroll for use either: (a) by a 
single individual on each of the Mac Computer(s) that you own or control, or (b) by multiple individuals on a single shared Mac Computer that you 
own or control. For example, a single employee may use MagicScroll on both the employee’s desktop Mac Computer and laptop Mac Computer, or 
multiple students may serially use MagicScroll on a single Mac Computer located at a resource center or library.

B. Volume or Maintenance License. If you obtained MagicScroll under a volume or maintenance license program with Apple, the terms of your 
volume or maintenance license will determine the number of copies of MagicScroll you are permitted to download, install, use and run on Apple-
branded computers you own or control. Except as agreed to in writing by Apple, all other terms and conditions of this License shall apply to your use 
of MagicScroll obtained under a volume or maintenance license. 

C. Apple ID. Use of the Mac App Store requires a unique user name and password combination, known as an Apple ID. An Apple ID is also required 
to access updates to MagicScroll and certain features and Services (as defined in Section 5). 

D. System Requirements. Apple Software is supported only on Apple-branded hardware that meets specified system requirements as indicated by 
Apple.

E. Content and Digital Materials. Title and intellectual property rights in and to any content displayed by or accessed through MagicScroll belong 
to the respective content owner. Such content may be protected by copyright or other intellectual property laws and treaties, and may be subject to 
terms of use of the third party providing such content. Except as otherwise provided in this License, (i) this License does not grant you any rights to 
use such content nor does it guarantee that such content will continue to be available to you, and (ii) you may not use, extract or distribute, commer-
cially or otherwise, on a standalone basis, any photographs, images, graphics, artwork, audio, video or similar assets (“Digital Materials”) contained 
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within, or provided as a part of, MagicScroll, or otherwise use the Digital Materials outside the context of its intended use as part of MagicScroll.

F. (Item removed)

G. Other Use Restrictions. The grants set forth in this License do not permit you to, and you agree not to, install, use or run MagicScroll on any non-Ap-
ple-branded computer, or to enable others to do so. Except as otherwise permitted by the terms of this License or otherwise licensed by Apple: (i) only 
one user may use MagicScroll at a time, and (ii) you may not make MagicScroll available over a network where it could be run or used by multiple 
computers at the same time. You may not rent, lease, lend, sell, redistribute or sublicense MagicScroll.

H. No Reverse Engineering. You may not, and you agree not to or enable others to, copy (except as expressly permitted by this License or by the Usage 
Rules if they are applicable to you), decompile, reverse engineer, disassemble, attempt to derive the source code of, decrypt, modify, or create derivative 
works of MagicScroll or any services provided by MagicScroll, or any part thereof (except as and only to the extent any foregoing restriction is prohib-
ited by applicable law or by the licensing terms governing use of Open-Sourced Components (as defined in Section 13A) that may be included with 
MagicScroll). 

I. Compliance with Laws. You agree to use MagicScroll and the Services in compliance with all applicable laws, including local laws of the country or 
region in which you reside or in which you download or use MagicScroll and Services.

J. Third Party Software. Apple may provide access to certain third party software or services as a convenience. To the extent that MagicScroll contains 
or provides access to any third party software or services, Apple has no express or implied obligation to provide any technical or other support for such 
software or services. Please contact the appropriate software vendor, manufacturer or service provider directly for technical support and customer ser-
vice related to its software, service and/or products.

K. Automatic Updates. If you opt in to automatic app updates, your computer will periodically check with Apple for updates and upgrades to 
MagicScroll and, if an update or upgrade is available, the update or upgrade will automatically download and install onto your computer and, if appli-
cable, your peripheral devices. You can turn off the automatic app updates altogether at any time by changing the automatic app updates settings found 
within System Preferences.

3. Transfer.
A. Apple Software obtained from the Mac App Store is not transferable. If you sell your Apple-branded hardware to a third party, you must remove 
MagicScroll from the Apple-branded hardware before doing so.

B. You may not transfer any Apple Software that has been modified or replaced under Section 13A below. All components of MagicScroll are provided 
as part of a bundle and may not be separated from the bundle and distributed as standalone applications. Apple Software provided with a particular 
Apple-branded hardware product may not run on other models of Apple-branded hardware.

C. Any copy of MagicScroll that may be provided by Apple for promotional, evaluation, diagnostic or restorative purposes may be used only for such 
purposes and may not be resold or transferred.

4. Consent to Use of Data. 
A. Diagnostic and Usage Data. If you choose to allow diagnostic and usage collection, you agree that Apple and its subsidiaries and agents may collect, 
maintain, process and use diagnostic, technical, usage and related information, including but not limited to unique system or hardware identifiers, 
information about your computer, system and application software, and peripherals, that is gathered periodically to provide and improve Apple’s prod-
ucts and services, facilitate the provision of software updates, product support and other services to you (if any) related to MagicScroll, and to verify 
compliance with the terms of this License. You may change your preferences for Diagnostics & Usage collection at any time by going to the Diagnostics 
& Usage setting on your computer and deselecting the checkbox. The Diagnostics & Usage setting is found in the Security & Privacy pane within 
System Preferences. Apple may use this information, as long as it is collected in a form that does not personally identify you, for the purposes described 
above. To enable Apple’s partners and third party developers to improve their software, hardware and services designed for use with Apple products, 
Apple may also provide any such partner or third party developer with a subset of diagnostic information that is relevant to that partner’s or develop-
er’s software, hardware and/or services, as long as the diagnostic information is in a form that does not personally identify you.

B. Privacy Policy. At all times your information will be treated in accordance with Apple’s Privacy Policy, which is incorporated by reference into this 
License and can be viewed at: http://www.apple.com/privacy/.
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5. Services and Third Party Materials. 
A. General. MagicScroll may enable access to Apple’s iTunes Store, Mac App Store and other Apple and third party services and web sites (collectively 
and individually, “Services”). Use of these Services requires Internet access and use of certain Services may require an Apple ID, may require you to 
accept additional terms and may be subject to additional fees. By using this software in connection with an iTunes Store account, Apple ID or other 
Apple account, you agree to the applicable terms of service for that account, such as the latest iTunes Store Terms and Conditions which you may access 
and review at http://www.apple.com/legal/itunes/ww/.

B. You understand that by using any of the Services, you may encounter content that may be deemed offensive, indecent, or objectionable, which content 
may or may not be identified as having explicit language. Nevertheless, you agree to use the Services at your sole risk and that Apple shall have no lia-
bility to you for content that may be found to be offensive, indecent, or objectionable. 

C. Certain Services may display, include or make available content, data, information, applications or materials from third parties (“Third Party 
Materials”) or provide links to certain third party web sites. By using the Services, you acknowledge and agree that Apple is not responsible for exam-
ining or evaluating the content, accuracy, completeness, timeliness, validity, copyright compliance, legality, decency, quality or any other aspect of such 
Third Party Materials or web sites. Apple, its officers, affiliates and subsidiaries do not warrant or endorse and do not assume and will not have any lia-
bility or responsibility to you or any other person for any third-party Services, Third Party Materials or web sites, or for any other materials, products, 
or services of third parties. Third Party Materials and links to other web sites are provided solely as a convenience to you. 

6. Termination. This License is effective until terminated. Your rights under this License will terminate automatically or otherwise cease to be effec-
tive without notice from Apple if you fail to comply with any term(s) of this License. Upon the termination of this License, you shall cease all use of 
MagicScroll and destroy all copies, full or partial, of MagicScroll. Sections 4, 5, 6, 7, 8, 9, 11 and 12 of this License shall survive any such termination.

7. Disclaimer of Warranties. 
A. If you are a customer who is a consumer (someone who uses MagicScroll outside of your trade, business or profession), you may have legal rights in 
your country of residence which would prohibit the following limitations from applying to you, and where prohibited they will not apply to you. To find 
out more about consumer rights, you should contact a local consumer advice organization.

B. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT, TO THE EXTENT PERMITTED BY APPLICABLE LAW, USE OF MAGICSCROLL AND 
ANY SERVICES PERFORMED BY OR ACCESSED THROUGH MAGICSCROLL IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO 
SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. 

C. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MAGICSCROLL AND SERVICES ARE PROVIDED “AS IS” AND “AS AVAILABLE”, 
WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND APPLE AND APPLE’S LICENSORS (COLLECTIVELY REFERRED TO 
AS “APPLE” FOR THE PURPOSES OF SECTIONS 7 AND 8) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO 
MAGICSCROLL AND SERVICES, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
AND/OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY, QUIET 
ENJOYMENT, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. 

D. MAGIC TELEPROMPTING DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF MAGICSCROLL AND SERVICES, 
THAT THE FUNCTIONS CONTAINED IN, OR SERVICES PERFORMED OR PROVIDED BY, MAGICSCROLL WILL MEET YOUR REQUIREMENTS, 
THAT THE OPERATION OF MAGICSCROLL OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE, THAT ANY SERVICES WILL CONTINUE 
TO BE MADE AVAILABLE, THAT MAGICSCROLL OR SERVICES WILL BE COMPATIBLE OR WORK WITH ANY THIRD PARTY SOFTWARE, 
APPLICATIONS OR THIRD PARTY SERVICES, OR THAT DEFECTS IN MAGICSCROLL OR SERVICES WILL BE CORRECTED. INSTALLATION OF 
THIS APPLE SOFTWARE MAY AFFECT THE USABILITY OF THIRD PARTY SOFTWARE, APPLICATIONS OR THIRD PARTY SERVICES. 

E. YOU FURTHER ACKNOWLEDGE THAT MAGICSCROLL AND SERVICES ARE NOT INTENDED OR SUITABLE FOR USE IN SITUATIONS OR 
ENVIRONMENTS WHERE THE FAILURE OR TIME DELAYS OF, OR ERRORS OR INACCURACIES IN THE CONTENT, DATA OR INFORMATION 
PROVIDED BY, MAGICSCROLL OR SERVICES COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL 
DAMAGE, INCLUDING WITHOUT LIMITATION THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION 
SYSTEMS, AIR TRAFFIC CONTROL, LIFE SUPPORT OR WEAPONS SYSTEMS.

F. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY MAGIC TELEPROMPTING OR AN AUTHORIZED REPRESENTATIVE SHALL 
CREATE A WARRANTY. SHOULD MAGICSCROLL OR SERVICES PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS 
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ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS MAY NOT APPLY TO YOU. 

8. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY APPLICABLE LAW, IN NO EVENT SHALL MAGIC TELEPROMPTING BE LIABLE 
FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF PROFITS, CORRUPTION OR LOSS OF DATA, FAILURE TO TRANSMIT OR RECEIVE ANY DATA OR 
INFORMATION, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR 
USE OR INABILITY TO USE MAGICSCROLL OR SERVICES OR ANY THIRD PARTY SOFTWARE OR APPLICATIONS IN CONJUNCTION WITH 
MAGICSCROLL OR SERVICES, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND 
EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF 
LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In 
no event shall Magic Teleprompting’s total liability to you for all damages (other than as may be required by applicable law in cases involving personal 
injury) exceed the amount of fifty dollars ($50.00). The foregoing limitations will apply even if the above stated remedy fails of its essential purpose.

9. Export Control. You may not use or otherwise export or re-export MAGICSCROLL except as authorized by United States law and the laws of the 
jurisdiction(s) in which MAGICSCROLL was obtained. In particular, but without limitation, MAGICSCROLL may not be exported or re-exported (a) 
into any U.S. embargoed countries or (b) to anyone on the U.S. Treasury Department’s list of Specially Designated Nationals or the U.S. Department of 
Commerce Denied Person’s List or Entity List. By using MAGICSCROLL, you represent and warrant that you are not located in any such country or on 
any such list. You also agree that you will not use MAGICSCROLL for any purposes prohibited by United States law, including, without limitation, the 
development, design, manufacture or production of missiles, nuclear, chemical or biological weapons.

10. Government End Users. MAGICSCROLL and related documentation are “Commercial Items”, as that term is defined at 48 C.F.R. §2.101, consisting 
of “Commercial Computer Software” and “Commercial Computer Software Documentation”, as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. 
§227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §227.7202-1 through 227.7202-4, as applicable, the Commercial Computer 
Software and Commercial Computer Software Documentation are being licensed to U.S. Government end users (a) only as Commercial Items and (b) 
with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Unpublished-rights reserved under the copy-
right laws of the United States.

11. Controlling Law and Severability. This License will be governed by and construed in accordance with the laws of the State of California, excluding 
its conflict of law principles. This License shall not be governed by the United Nations Convention on Contracts for the International Sale of Goods, the 
application of which is expressly excluded. If you are a consumer based in the United Kingdom, this License will be governed by the laws of the juris-
diction of your residence. If for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the remainder 
of this License shall continue in full force and effect. 

12. Complete Agreement; Governing Language. This License constitutes the entire agreement between you and Apple relating to the use of 
MAGICSCROLL and supersedes all prior or contemporaneous understandings regarding such subject matter. No amendment to or modification of 
this License will be binding unless in writing and signed by Apple. Any translation of this License is done for local requirements and in the event of a 
dispute between the English and any non-English versions, the English version of this License shall govern, to the extent not prohibited by local law in 
your jurisdiction.

13. Third Party Acknowledgements.
A. Certain components of MAGICSCROLL, and third party open source programs included with MAGICSCROLL, may be made available by Apple on its 
open source website (http://www.opensource.apple.com) (“Open Source Components”). Acknowledgements, licensing terms and disclaimers for such 
components are contained in the electronic documentation for MAGICSCROLL. Please refer to the electronic documentation since you may have addi-
tional rights in the Open Source Components. You expressly acknowledge that if failure or damage to Apple hardware results from modification of the 
Open Source Components of MAGICSCROLL, such failure or damage is excluded from the terms of the Apple hardware warranty.
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Forward by the designer

Let me introduce myself.  I’m Japji (Jop-gee) Singh Khalsa, the design-
er of MagicScroll.  I’ve been working in the film/video business for over 
40 years.  The last thirty of those years has been spent growing the larg-
est teleprompting rental business in Northern California, called Magic 
Teleprompting, Inc. 

Teleprompting has come a long way in those twenty years.  When I 
first started, paper scroll systems were the most anyone could expect from 
a teleprompter. However, computer based prompters slowly made their way 
into the market as the technology advanced and the prices came down.  
Pretty soon, the DOS world was saturated with programs-- all of them tout-
ing different features and different prices.  Unfortunately, prompting on the 
Macintosh® was a slightly different story. Around the time of the introduc-
tion of the Mac Plus, a couple of people tried to write a prompting program 
for the Mac.  It was feature filled, but it lacked two essential elements of a 
prompter.  It didn’t provide NTSC composite output to allow interfacing 
with the thru-the-lens display unit, and most importantly, it didn’t scroll 
smoothly.  Fortunately, technology eventually caught up with imagination in 
the form of MagicScroll Version 1, introduced in 1991.

Choosing to write a program for the Mac was no small task, espe-
cially considering the preponderance of inexpensive DOS based systems.  
I thought my experience in the business and my years of teleprompting 
allowed me to design a program from the ground up.  A program that 
wouldn’t be just a glorified word processor, but one that would cater to the 
special needs of teleprompting.  I wanted to write a great prompting pro-
gram.  I believe MagicScroll is just that.  It provides a suite of prompting 
tools that are practical, powerful and graceful but not overly-ambitious.   
With practice and experimenting, these tools can allow a novice to move 
quickly into the realm of great prompting.  

Since the introduction of Version 1, MagicScroll has continuously 
evolved as we moved through versions 2, 3, 4, 5 and now the introduction of 
MagicScroll Version 6 for Mac OS X, designed for the latest versions of both 
the Macintosh line of computers and the Mac operating system.

Integrating customer feedback, and our own experience using 
MagicScroll in our rental business, we have selectively added features while 
increasing performance and ease-of-use.  A novice with basic Mac skills 

Japji Khalsa
President, Magic 

Teleprompting, Inc.

MagicScroll
Rocks!

Continued next page...

Forward



2

MagicScroll: Teleprompting for Macintosh

2

MagicScroll: Teleprompting for Macintosh

can still easily operate MagicScroll, while a more dedicated professional will 
find new functionality that will help him/her achieve excellence in the field of 
teleprompting.

Our previous version (5.1.3) has been a workhorse for many years. But 
as Apple issued refinements to the OS, slowly things began to break, and 
our dedicated users requested an update to their favorite prompting system.  
Some users even tried other brands, but kept reminding us how MagicScroll 
is so much better and easier to use.  

Our focus over the development of Version 6 was to maintain our famed 
ease of use and to ensure a reliable app.  We didn’t go crazy on adding fea-
tures, though a few new ones have made it into this version. 

Over the course of 3 years, Version 6 faced many technical challenges as 
we re-wrote the code from the ground up. We’ve met those challenges, and 
now have a solid, simple-to-use, powerful solution for Macintosh that should 
keep our users happily prompting for the foreseeable future.

And yet, Most of MagicScroll’s features will go unnoticed by the produc-
ers and directors who expect the teleprompter to “just work”.  But you, as an 
operator/owner, will know that great teleprompting can and does happen.  I 
hope that MagicScroll helps you achieve that greatness.

Thank you for choosing MagicScroll as your prompting software solution.

Japji Khalsa
President, Magic Teleprompting, Inc.

P.S. To help guide you towards great teleprompting, I’ve included 
a section in this manual on teleprompting tips– not just on how to use 
MagicScroll, but tips on teleprompting in general that have come from my 
years in the business.
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MagicScroll Rocks!

We are pleased you have chosen MagicScroll™.  We believe you will 
find it indispensable as a teleproduction tool that will make you and 
your talent look good.

MagicScroll is the premier professional teleprompting system avail-
able for the Macintosh.  It enables your Macintosh computer to scroll 
videotext smoothly on a teleprompter.  MagicScroll will output this 
videotext to your attached monitor devices that then feed your thru-
the-lens or podium prompter display.

The features of MagicScroll include:

1) Fonts- the ability to set your script in any Font and Size that is 
installed on your Macintosh, as well as to mix and match fonts.  

2) Colors-the ability to use different colors in your script.

3) Find and Find/Replace- helps you find places in your script and 
make changes to words or phrases.

4) Bookmarks- allow instant locating of pre-defined sections of your 
script.  Bookmarks can be named and saved with your document.

5) Paperclips- allow instant marking of points in your script while 
scrolling.  Up to 128 paperclips can be placed and saved with your file.

6) Script Queue- allows automated “linking” from the end of one file/
script to the beginning of the next file in the “queue.”

7) Timer- a built in stopwatch for timing rehearsals or takes.

8) An “On Screen”  (Preview) window- allows the operator to see 
exactly what is being output to the prompter monitors.

9) Loops- lets the text continually cycle between two defined book-
marks.

About MagicScroll
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10) Blanking Switch- to set your output monitor quickly to black for 
stage blackouts. New in V6 is the ability to choose a graphic instead of 
black when blanking is on.

11) Inverse Video- switches your output text from white on black to 
black on white.

12) New in V6 - Ability to fade the top and bottom edges of the scroll-
ing window to bring focus to the current spoken text. The amount of 
fade is adjustable in preferences.

13) Moveable Pointer- a choice of four moveable pointers helps the tal-
ent and the operator keep their places in the script. 

15) Reverse horizontal/vertical scan- allows you to reverse the output 
image while still viewing a non-reversed image on your computer.

16) New in V6 - The return of the Script Meter!  Removed in V5, we’ve 
brought back the graphic meter that shows you approximately where 
you are in the script as you scroll.

This manual will help you get the most out of MagicScroll.  MagicScroll 
was designed to be as easy to use as possible.  That’s why we selected 
the Macintosh as a platform.  Be sure to read this carefully.  
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Installation

1. Download and Install MagicScroll from the App Store, and be sure it’s placed 
in your Applications folder..

2. Start MagicScroll by double-clicking its icon in the MagicScroll folder. 

3. If you have a 2nd output monitor attached to your Mac, Configure 
the video output by selecting the “Set Video Output” menu under 
the main MagicScroll menu. Select the monitor that you want to 
use for scrolling output. Click OK.

4. Review the preferences settings by selecting “Preferences...” 
under the main MagicScroll menu. 

7. Have fun using MagicScroll! If you encounter problems, refer 
to the manual. Should you need to phone in for assistance, please 
check the appropriate section of the manual before calling.

In order to work with MagicScroll, you need:

• A Macintosh computer meeting the operating system requirements for Mac OS 
X v10.11 (El Capitan) or later

• At least 40 megabytes free on your hard disk.

• A second video monitor attached to your Mac to provide the image of the 
smooth scrolling script to the operator and/or the talent.

You might also find it helpful to own:

•A word-processing application, such as Microsoft Word..

Before you continue with the instructions in this manual, make sure that:

•You know how to perform basic Macintosh tasks. For example,, you should 
know how to select icons, text, and other objects by clicking, double-clicking, and 
dragging; how to move, resize, and scroll the contents of windows; how to choose 
commands from menus and respond to alerts and dialog boxes; and how to create 
and name new folders, copy and name files and disks, and do other work in the 
Finder™.

Installation
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Configuring the “Displays” panel in System Preferences.

Although configuring MagicScroll for scrolling videotext output is as simple as drag-
ging the scroll icon to the monitor, the following section provides more detailed infor-
mation on configuring your monitors with the Displays setting.

Open “System Preferences” located in the Apple Menu in the upper left of your 
screen.  
Choose “Displays” from the “Hardware” section of your preferences.

The “Displays” panel appears in each of your attached monitors.

If you have more than one external video monitor attached, a button called “Arrange” 
will appear.  Press “Arrange” in order to properly position your monitors.

We recommend DIS-abling “Mirror Displays.”  (Mirror displays puts the same image 
in ALL your attached monitors.)

Normally, you would drag each monitor icon until its position corresponds to the 
location of the actual monitor. However, since the MagicScroll monitor is generally 
used only for MagicScroll, we’ve found that placing it at either the top-right or low-
er-left corners works best. This helps keep your cursor from disappearing off the edge 
of your main monitor.  Avoid placing it at the lower right corner, as MagicScroll and 
other programs tile new windows in such a way as to sometimes cause them to over-
lap into the MagicScroll monitor.

The “Main” Monitor contains the standard Macintosh menu bar and desktop 
and is identified by a tiny Menu Bar across the top. You’ll use it as your “base of 
operations” -- while using a NON main monitor for your video output scrolling.

If you need to change Main monitors (i.e. if the NTSC/Output monitor has the 
tiny menu bar), then drag the tiny menu bar from the current monitor icon 
(still using the Monitors CDEV) and place it onto the one you want as your main 
monitor.

Close “Displays.”

If you have not yet configured MagicScroll for video output, choose the “Video 
Output” option under the main MagicScroll application menu item and follow the 
previous configuration instructions.
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Boot MagicScroll by double 
clicking the program icon.  
The operator’s screen, or 
the “Main” monitor will 
display the MagicScroll 
Tool Bar, and possibly other 
windows including the pre-

view window, Script Queue, and time.  Most features of MagicScroll 
can be accessed through the Prompter Tool Bar.  This ‘floating’ toolbar 
is moveable but not resizeable or closeable.  The panel contains a 
combination of icons and switches - clicking an icon will activate a 
particular function.  

The switches are activated by simply clicking them, which toggles 
them on and off. Each of the icons in the toolbar also have a label 
describing their function.

The Scroller Icon

 The Scroller icon activates the forward and backward scrolling of 
your teleprompter script.  This scrolling action works differently 
than standard Macintosh scrolling windows because it activates the 
smooth scrolling engine within MagicScroll. In order to get smooth 
scrolling on your output monitor you must use this icon-- not the 
Macintosh window scrolling arrows at the top and bottom of a scroll-
ing window.  Of course, you can still use the window scroll arrows to 
get around your document/script-- but text will not scroll smoothly.
 
To scroll, click the Scroller icon or press the Command-G keys.  This 
initializes the scrolling monitor to your current place in the script and 
activates the smooth scrolling engine.  It also activates the on screen 
Preview window, so you can see exactly what’s going out to your 
prompter monitors. If you do not have an external video monitor, 
MagicScroll will scroll your text in FULL Screen on your computer. 

When you are in scroll mode, the icon will turn RED and animate to 

Icons & Tools

The MagicScroll
Tool Bar

The Scroller Icon

In Version 6, you can use 
the ESC (Escape) key  to 

exit scroll mode.
Or, set your prefs such 

that a mouse click exits 
scroll.
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help you not forget that you are scrolling (versus editing).

Using your mouse or trackpad, move the cursor up to make the script 
scroll forward and down to scroll the script backward. To stop scrolling 
, press the ESC (escape) key. You can pause the scrolling by pressing the 
Return key.  Press the Return key again to resume scrolling. 
 
The “Preview” window can be permanently left open and placed in a 
convenient position on your screen.  From the Window menu, choose 
Show Preview Window.  The size of the preview window can be set by 
selecting Preferences (Video Output submenu) from the File menu.

Loops/Blanking/Linking

At the center of the toolbar are a set of buttons for activating and de-activat-
ing different features.  Clicking the icon will toggle the switch from on to off 
and vice-versa.  

The Loops switch allows you to cycle your script continuously between 
a bookmark that has been defined as the start of the loop,  and a second 
bookmark that has been defined as the end of the loop. (See Bookmarks).  
During scrolling, when you get to Loopmark #2, you will be automatically 
returned to Loopmark #1.  It’s important to place the starting Loopmark 
before the second for this feature to work properly.  Because the Loop fea-
ture and the Linking feature are mutually exclusive, only ONE of these can 
be active at a time.  The Loop function is not document-specific, so if you 
switch from one script window to another, the Loop feature will remain acti-
vated.   

The Blanking switch turns turns the text output to your monitor on and 
off, sending “black” to the monitor when in the “ON” position.  As a failsafe 
mechanism, when you click the Scroller icon, MagicScroll automatically 
turns the Blanking switch off.  When you enter “Scroll mode” your output 
will automatically be activated, and conversely, when you exit scrolling, the 
output will return to “black.” This switch does not have a corresponding 
menu item.

New in V6 is the ability to set a custom blanking image/logo. In the prefer-

The Loops, Blanking 
and Linking 

buttons.

Icon turns red 
WHILE Scrolling

Set a Custom 
Blanking Image

New in Ver. 6!
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ences window, drag an image from your finder into the box.  Check the box 
to use/not use the custom blanking image.

The Linking switch activates the linking feature of the Script Queue win-
dow.  When Linking is OFF, a single script/file will scroll until it gets to the 
end of the file, and then it will stop.  When Linking is ON, scripts will scroll 
directly from one file to another without having to stop scrolling, bring up a 
new window, and start scrolling again.
 
Colors Icon

By clicking the colors icon, you’ll bring up the Apple Color wheel.  
From here you can alter the color of selected text.  Select the text you 
want to change, and then click within the wheel.  You can also drag 
colors to the boxes below to define your favorite, most used colors.

You can also select different colors by choosing one of the alternate 
color pickers, including the HSB Slider, Swatches, Images, and pencils.

NOTE that, if you typically set your scrolling window to inverse, 
(white text on black), if you change the color of the text to white, it will 
appear on the output screen as black which will make it appear blank 
against the black background.

The Font Icons

The Font icon activates the Fonts window, allowing you to choose a 
font, style, size and color for your teleprompter text.

If you have not selected any text before opening this window, any 
changes you make will apply to the entire document.  If you want to 
just change specific text, be sure to select it first.   Alternatively, you 
can change the font styles of the entire document by holding down the 
option key while selecting Font, Size, Style or Color from the menus at 
the top.

To change the size of text, click the desired font size from the menu.  

Apple Color Wheel

Sliders/Swatches/
Pencils/Etc

The Font Icon

Decrease/Increase 
Font Size

The Colors Icon
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If the menu doesn’t have a size you like,  you 
can also enter a specific point size in the area 
just below “Size” .  For quick size changes, use 
the “Smaller/Larger” icons at the right of the 
toolbar.  If text is selected, it’ll change just the 
text, otherwise it will change the entire docu-
ment.

The font and size choices are also available in 
the menubar across the top of the operator’s 
screen. By choosing Format, or Font Size, you 

can alter all of the document, or just selected text.

You can highlight words or sections of your documents/scripts with 
underlines, italics, bold or patterns.  Select the text to be highlighted, 
and using either the menus at top, or the Font window, apply the style 
you want.  You can also set the style of selected text by using the corre-
sponding Command key combinations:

  Command-B for Bold
  Command-I for Italics
  Command-U for Underline 

  Command-Option-C copies a STYLE
  Command-Option-V pastes style onto selected text

  Command - Up/Down Arrow jump to top/end of file.



11

Icons & Tools

 The Script Queue Window

Activate the Script Queue feature by choosing “Show Script Queue” from 
the Window menu. Script Queue gives you control over the scrolling order 
of your different scripts/files.  Any open document will appear in the Script 
Queue window, with newly opened documents appearing at the end of the 

list.  You can re-order this list by clicking a file name and 
dragging it up or down to a new place in the queue.  The 
current working document is shown in bold letters.

At the far left of each file name is a checkmark that can 
be toggled on/off by clicking it. A checkmark next to a file 
name indicates that the script will be included in the queue 

while scrolling with the Linking switch turned “On.”  To remove, or bypass, a 
script from the queue, turn the checkmark off.

To the left of each file name is a pop-up menu beneath the “>>” column 
that allows you to access any bookmark within a script.  Simply click the 
pop-up menu and select the desired bookmark.  MagicScroll will automati-
cally bring up the selected script and go to the indicated bookmark.

Script Queues can be saved and named under the “File” menu.  

Pre-defined Text Style

It may be helpful to create favorite styles, which include a font, 
size, and line spacing that you can apply to a document or 
selected text quickly.  Styles are created in the tools and menus 
at the top of each document..  

To create a predefined style, first format some text to the style 
you want by adjusting the font, size, and line spacing. Select the 
formatted text. Then choose Styles>>Other from the menu. The 
window that appears shows you a list of the current Styles. 

Selecting “Other” brings up a window that hightlights the 
current style of the selected text.  Choose the radio button 
“Document Styles” then choose “Add to Favorites” and a dia-
logue will pop up, asking you to name the new style. 

Styles Menu at top of document

The Script Queue 
Window

Creating Text Styles
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Give your style a memorable name, and be sure to select the 
“Include the font as part of the style”. Then click “Add”.  Your 
new style will now appear in the Styles menu of each document.

To delete a style, select “Other” from the document’s Style menu 
at the top left of the document. Click the radio button “Favorite 

Styles”.  Select the style you want to delete from the popup menu of dif-
ferent styles.  Click the “Remove from Favorites” button.

The Sidebar
 
Each open script window has a sidebar along the left side of the win-
dow.  This sidebar contains tools and references to help the prompter 
operator manipulate and access the script.  In the sidebar you’ll find 
the Pointer, Paperclips, Bookmark Indicators and Line Numbers (when 
activated).

Pointer

The pointer sets a reference point for the talent and the operator while 
scrolling. It is displayed on the output screen and can be moved up or 
down by just clicking and dragging it.  

Paperclips

Paperclips mark places in your script to allow quick access or referral.  
They are similar to Bookmarks except that you can’t give them names 
and you can only go to them in sequence. 

To place a paperclip while you are NOT scrolling, click the Paperclip 
icon at the top of the sidebar and drag it to a place within the side-

Name your Style

Remove a Style

The Sidebar, including:
Paperclip, Bookmark, 
Pointer and line num-

bers.
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bar next to the text you want to mark.   To place a paperclip WHILE 
SCROLLING, press the SPACE BAR. When you stop scrolling, your 
paperclips will appear in the sidebar at the point in the script where 
you clicked the space bar.

You can go to paperclips WHILE SCROLLING, or while NOT scrolling. 

To go to a paperclip, press OPTION-TAB or choose “Go To Next 
Paperclip” from the Utility menu.  This will cycle you through the 
paperclips sequentially.  To cycle backwards through paperclips, hit the 
OPTION-SHIFT-TAB keys.

You can also “Control-Click” in a blank area of the Sidebar to pull up a 
dialogue for next or previious paperclip.

You can clear all of your paperclips by choosing Clear Paperclips from 
the Utility menu.

Bookmarks

The sidebar also indicates any bookmarks you’ve set.  When you go to 
a bookmark, MagicScroll places the desired bookmark just to the right 
of the Pointer. The icon of the bookmark will indicate the number of 
the bookmark.

By CONTROL-Clicking any set bookmark (blue) in the 
side bar, you can change it’s ‘status’.  

Start makes that bookmark the starting point for looping 
text when using the looping feature.

End makes that bookmark the end of a loop.
Rename will prompt you to change the current name of 

the bookmark.
Remove will delete the selected bookmark.

Cycling through Paperclips

Bookmarks/Status 
(Control click)



MagicScroll: Teleprompting for Macintosh

14

MagicScroll: Teleprompting for Macintosh

Line Numbers

You can show the line numbers of your document in the sidebar by 
choosing “Show Line Numbers” from the View.  
 
The Timer/Stopwatch

To show the Timer window, select “Show Timer Window” from the Window 
menu.

The timer is activated by pressing the green arrow.  To stop or pause timing, 
press the  red X.  Click the red loop to reset the timer.

You can show the timer in the Preview/Output windows by activating “Show 
Timer in Output window” in MagicScroll Preferences.
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The menu bar in MagicScroll consists of the standard “MagicScroll”, 
“File” and “Edit” menus and additional ones called “Font,” “Size,” 
“Style,” “Color,” “Utility” and “Window.”  Most, but not all, of the func-
tions can also be accessed through the Prompter Control window and 
the corresponding icons or buttons.  You should know how to Open a 
file and be able to navigate around your hard drive to find the file you 
want.

The MagicScroll menu...
 
Most of the menu options here are standard options for all applica-
tions. The following goes into detail about MagicScroll specific items. 

Preferences:

The Preferences menu reveals the dialog box that allows you to set 
various MagicScroll attributes such as mouse scrolling sensitivity and 
various other scrolling attributes.

The sensitivity of your scrolling movements can be cusomized with 
the “Mouse Sensitivity” Slider.

Enabling “Show Timer in Scrolling Window” places the time of the 
timer (but not the buttons) in the upper right corner of the 
scrolling window.

“Scroll Full Screen while NO other monitors attached” is an 
option when the output video is set to scroll to your main screen 
(Or, in many cases, your only screen)  
   When activated, your main screen will fill with scrolling text, 
covering all the tools and edit windows behind it. Upon exit-

Menus and Windows

The MagicScroll Menu
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ing scroll mode, the screen reverts to your working environment that 
includes tools, files and preview window.
   If it is NOT activated, then when you enter scroll mode, the text 
scrolls only in the preview window at the size it was set to.

The “Fade Top and Bottom Edges” is a new feature in Version 6. It 
allows you to add an adjustable gradient fill over the top/bottom edges 
of your output screen.  This can help ‘bring focus’ to your reader,  much 
like a pointer might.  The amount of fade is adjustable, with the MOST 

fade enabled when the slider is to the far left, with less fade 
as you slide the adjuster to the right

“Live Update Delay” adjusts the responsiveness of display-
ing changes made to a document in the output window. 
Changes made to a document will update more quickly on 
the output monitor with the slider to the furthest left. As 
you slide right, updates will happen more intermittently.  
Conversely, if the slider is to the far left, your Mac will be 
using more processing power to display changes, and other 
functions may slow down.  We find a happy medium is 

best, depending on the speed of your particular computer.

“Mouse Click Exits Scroll Mode” allows you to click your mouse to exit 
scrolling instead of using the escape key.

“App Background Exits Scroll Mode” causes MagicScroll to stop scroll-
ing, exiting scroll mode, if you should click on another app while scroll-
ing. 

Video Output...

The Video Output Preferences dialog box allows you to set various 
attributes of the scrolling text output display and preview window.
The top region of this dialog box allows you to specify on a multi-
ple-monitor Macintosh which monitor will be used for scrolling your 
text . You should select the monitor that is being viewed by the talent. 

New in Ver. 6!
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If the monitor selected is not the main monitor, the monitor will be 
blacked out and the scrolling text will be immediately displayed.

The “Inverse Video” checkbox changes the scrolling text 
output to black letters on a white background, instead 
of white letters on black. All other colors will remain the 
same.

The “Flip Horizontal” and “Flip Vertical” checkboxes allow 
you to flip the output display on the horizontal or vertical 
axis.  These options are useful if your prompter monitors 

do not support hardware flipping for use with a prompter mirror. 
These settings will not affect the Preview window; the image in the 
Preview window will be oriented correctly during scrolling.

The Align Scrolling Text popup menu allows you to set how you want 
your text displayed on the output/teleprompter window. 
 Size to Fit: Uses your text margins to fit the text left-to-right 

on the output monitor.
 Actual Size: Aligns your text at the top/left 
of the output screen and uses the actual size of your 
text to fit on the screen.
We’ve found that “Actual Size” is the best for most 
situations.

The “Preview Window” popup menu allows you to set the size of the 
Preview Window as a factor of the output display. Your options are 
Full size, Half size or Quarter size. Full Size is NOT an option when 
you only have one/main monitor. (Though you ‘can’ scroll full size.)

NEW in version 6 is the (return of) the Progress Meter.  At 
the right side of the preview window, the blue overlay and 
it’s corresponding white dot show you approximately where 
you are in the script.  This updates live as you scroll, so 
you’ll be able to see how far you’ve scrolled, and about how 
far you have to go to the end of the script.

Setting the output monitor

Preview half/quarter size

New in Ver. 6!
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The File menu...

New: (Command N)

Opens a new untitled window. You can either type in new text or paste 
in portions of another file.  

Open... (Command O)

Opens either a MagicScroll document or an ASCII text file.  
You may also open files from the Mac’s Finder by dragging the file(s) 
over the MagicScroll application icon.  The maximum number of open 
files is only limited by the amount of RAM allocated to MagicScroll.

Recent Files: 

MagicScroll remembers your last ten documents that you’ve had open.

Close: (Command W)

Closes a window. MagicScroll typically auto saves your work, and you 
will not likely get an alert asking if you want to save your document.

Save: (Command S)

Updates the file you are working on with the latest changes, by saving 
text changes, paperclips and bookmarks.  

Duplicate: (Command Shift S)

Opens a new window with all of the content of the current file. A dia-
logue for naming the newly created (clone) appears.

Rename: 

Highlights the text at the TOP of the document, where a new name can 
be entered.  This will NOT make a copy of the previous file, but just 
rename the current file.

The File Menu
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Move to...

Provides a dialogue to navigate to a new folder or drive 
to save the current file.  The newly moved file will then 
be located in the new location, and will NO LONGER be 
located in it’s original folder or drive.
 

Revert To: 

This allows you to revert to your last opened version of a 
script/file.  Any changes you made since you opened the file 
will be discarded.  You can also “Browse All Versions” of a 
document, which will bring up a Time Machine window of 
recent documents.  Apple’s Time Machine must be active 
for this to work, otherwise the option will be greyed out. 

Open Queue/Save Queue/Save Queue as...

These function the same as standard document save/open 
menus, but work only with Queues that you’ve created in the 
script Queueu menu.  We recommend saving the Script Queue 
at the same file heirarchy as the script files you’re working with.  
So if your current script files are in a folder called “Big Show 
Files”, then place the saved Queue file in the same folder.

Page Set Up...

Allows you to choose the correct parameters for your print-
er.  Since most teleprompter files utilize large fonts, a helpful 

MagicScroll trick is to set the “Size” or “Reduction” setting to a num-
ber between 30-50%.  This keeps your document’s image/margins/
appearance in tact, while reducing it so that it prints on less pages.  

Print... (Command P)

Takes you through the standard print dialogue for your printer.

Browsing older versions
(Time Machine active)
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The Edit Menu

Undo/Redo: (Command Z)

If you try a change of font style or edit some text and find it is not to 
your liking this function allows you to undo the change immediately.

Cut: (Command X)

Highlight the block of text desired and Cut will move it into your 
Clipboard.  

Copy: (Command C)

Copies highlighted text into the Clipboard.

Paste: (Command V)

Pastes whatever text you’ve either Copied or Cut into the clipboard to 
the current insertion point in your document.

Paste and Match Style: (Command/Option/Shift/V)

Pastes copied text into your document and matches the style of the text 
around it..

Copy and Paste STYLE ONLY 
(Command option C/Command Option V) 
This command is NOT in this menu, but is instead in the Format 
menu.  We felt it important enought to mention it here. This can be 
VERY helfpul when fine tuning a prompting script. Copies the text 
style (color/size/font), but does not copy the actual text. The Style 
can then be pasted ‘onto’ other text. For example, to change all the 
“BOB ENTERS” to a different color, you can ‘paste’ the color onto each 
instance.

Delete: 

Eliminates selected text but does not put it into the clipboard for past-
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ing in later.

Select All: (Command A)

By highlighting this command, you select all the text in 
the current active window.  If you want to change the font, 
size or FontSet of the entire script, you can either Select 
All, or alternatively, hold down the Option Key while 
selecting the text style to be applied.

Find / Find and Replace... (Command F / Commond 
Option F)

Brings up a find window.Finds a particular word, also 
allows you to replace that word with other text. Find 

Next/Find Previous etc. can also help you navigate your document.

Spelling and Grammar:

Select whether and how you want MagicScroll to check for 
Spelling and Grammar errors.

Substitutions:  

Check the options you prefer.  Note that by choosing “Show 
Substitutions”, you’ll be brought to a macOS setting that lets you 
program “Text Replacement” short cuts. For example, you can 
create a shortcut that automatically types “Video Plays Here” when 
you type VPH.

Transformations:  

While we prefer upper and lower case for our prompter scripts, 
sometimes a presenter might prefer ALL CAPS.  You can easily 
change all or part of a document with these menu items.

The Find Menu and
dialogue at top of the document
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Speech:  

Speaks aloud selected text, or from the top of the document. 
The pace, and choice of voice can be adjusted in macOS set-
tings under Dictation and Speech.

Start Dictation:  

You can now speak into your Mac’s microphone to dictate text 
straight into a MagicScroll document. The first time you use Start 

Dictation, you will be shown a dialogue to activate 
Enhanced Dictation.  We recommend you install the 
1.2GB file. If you choose not to, Dictation will attempt 
to use the internet/Apple to translate your words. 

Emoji and Symbols:  

Emoji’s have made it to the world of teleprompting! 
This menu brings up a dialogue 

to insert an Emoji or symbol into your doc-
ument. The emoji will scroll with the docu-
ment, just as if it were a character in the text.

  
New in Ver. 6!
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The Format >> Font Menu:

Most standard fonts and style options are available through this 
menu.  If you want to change the font, font style, or size of the entire 
document, hold down the Option key while selecting the font. This 
will apply the same selected formatting to the entire document.

Show Fonts (panel) (Command T) brings up a window that gives 
you full control over the color, size, font and other typographic fine 
tuning. You can specify a specific font size in the box just below “Size”, 

or use the slider to increase/decrease your text size. 

Copy Style can be VERY helfpul when fine tuning a prompt-
ing script. Copies the text style (color/size/font), but does not 
copy the actual text. The Style can then be pasted ‘onto’ other 
text. For example, to change all the “BOB ENTERS” to a dif-
ferent color, you can ‘paste’ the color onto each instance.

The Format >>Text Menu:

Alignment: 
Selected text can be aligned right, left, center and justified to the mar-
gins.

Writing Direction:

Change the default setting of left to right with caution!

Show Ruler: 

This reveals and hides the ruler that shows the margin and 
tab stops at the top, in addition to the formatting options 
such as style, Size, etc.

The “Font” Panel

The “Format” Font Menu

Rulers ON (top) / Rulers OFF (Below)
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Font Size:

Choose from a set of pre-set sizes to apply to selected text, or to then 
entire document.
If you want to change the font size of the entire document, hold down 
the  Option  key while selecting the size. 

You can also bump up by one point the size of the current selection 
(or the entire document when used with the Option Key) by selecting 
“Increase Font Size” You can decrease the size by one point by selecting 
“Decrease Font Size.”

The Utility Menu:

Several of the special MagicScroll features that help you navigate your 
script are in this menu.

Show Line Numbers: 

Displays the line number in the sidebar of your document. These do 
not display on the output screen.

Set Bookmark: (Command-Shift-B)
New in version 6 are an unlimited number of 
bookmarks.  The bookmark sidebar icons are 
described in detail on page 15.

To set a bookmark at a specific point in your 
script, place the insertion point or select a word or phrase at the point 
in your script where you want to place the bookmark. (We recommend 
you don’t select much more than 20 characters of text.)

Next, hit the Command, Shift and B keys, or alternately, choose “New 
Bookmark” from the menu.. 

The Create Bookmark dialog box will appear, asking you to name 
the bookmark. If text is selected in your document, the selection will 
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appear as the default name.  If no text is selected, then the previous 
name of the bookmark will appear as the default name.  If the mark 
has not been named before, and no text is selected, then the default 
name will be “Bookmark #”. If you want to name it something other 
than what comes up, just type the new name into the Bookmark 
Name field.

Now click OK or press the Return key.  If you change your mind about 
setting a bookmark, click Cancel.

MagicScroll puts a Bookmark icon in the Sidebar of your script to 
help identify the location and number of bookmarks.  See the Sidebar 
section on page 17 for more information on the sidebar.

Go To Bookmark:  (Command-# for 1-10)
    (Command-Option-# for 11-20)
    (Command-Control-# for 21-30)
You can quickly go to a pre-set bookmark in one of three ways.   
1) Choose “Go to Bookmark” from the Utility menu. 
2) Use the keyboard equivalents as noted above. These keyboard com-
mands can be used while scrolling, allowing you to jump quickly to 
any marked place in your script without exiting scroll mode.  
3) In the Script Queue window you can go to any bookmark in any 
script by clicking the bookmark pop-up menu. (See page XX for more 
info on the Script Queue window)

Remove Bookmark: (Menu or Control click the actual bookmark)

New in version 6, ability to delete individual bookmarks.  Select the 
bookmark you want to remove from the menu, and it will then be 
deleted... there is NO dialogue asking to confirm this.

Clear Bookmarks: (Menu or Control click the actual bookmark)

Select this option to delete all of your bookmarks.  A dialogue will ask 
you if you really want to do this. To delete an individual bookmark 
use the menu above this one..

Going to Bookmarks 
with Script Queue
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Go To Next/Prev Paperclip:    Next (Option-Tab)
    Previous (Shift-Option-Tab)

Paperclips mark places in your script to allow quick access or refer-
ral.  They are similar to Bookmarks except that you can’t give them 
names and you can only go to them in sequence. See the section on 
the Sidebar in the “Icons and Tools” Chapter, page 14, for a complete 
description of the use of paperclips.

Clear Paperclips:

This clears (deletes) all of the current document’s paperclips. You can 
clear individual paperclips by dragging them off of the sidebar and 
releasing the mouse.

The Window Menu:

The Window menu lets you quickly move to any open file/script by 
selecting the one you want.  It also gives you control over some of 
MagicScroll’s program windows and other features.

Minimize

Contracts the current window off the screen and into the dock.  Click it 
in the dock to expand it back to its full size.

Zoom

Expands the current window to the full size of your screen.

Go into Scroll Mode: (Command-G)

Use this menu item to begin scrolling. Alternately, use the green scroll 
icon in the toolbar, or the Command G (for GO) key combo.  The 
ESCAPE KEY ENDS SCROLLING

Various Utility menus and windows
Select these to show or hide them.



Keyboard Shortcuts

Scroll Mode Keyboard Shortcuts

The following keys perform various functions while in scroll mode.

Spacebar  Set paperclip. This sets a paperclip at the line where the prompt arrow points in the script.

Option + Tab Go to next paperclip. This immediately moves the teleprompter script to the next paperclip 
location.

Shift + Option + Tab Go to previous paperclip. This immediately moves the teleprompter script to the previous 
paperclip location.

Command + [1..0]   Goto Bookmark 1 through 10
Command + Option + [1..0] Goto Bookmark 11 through 20
Command + Control + [1..0] Goto Bookmark 21 through 30

T Start/Stop timer from running.

Option + T Reset timer.

Escape Exits scroll mode

Return Hitting it once pauses scrolling -- hitting it again begins scrolling at the pre-pause pace.

The following keys perform various actions while in normal (non-scroll) mode.

Command + N New Document

Command + O Open Document

Command + W Close Document

Command + S Save Document

Command + P Print Document

Command + Q Quit Application

Command + Z Undo/Redo edit operation

Command + X Cut selected text

Command + C Copy selected text

Command + V Paste selected text

Command + A Select all

Command + F Find & Replace

Keyboard Shortcuts
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Here’s a handy reference for all the keyboard commands and shortcuts in MagicScroll.  Of 
course, many of these items are activated through Menus and Icons. However, as you become 
more comfortable with the features in MagicScroll, you’ll find that using keyboard commands 
will increase your productivity and speed.



28

MagicScroll: Teleprompting for Macintosh

28

MagicScroll: Teleprompting for Macintosh

Command + + Increase font size of selection, or entire document if no text is selected

Command + - Decrease font size of selection,  or entire document if no text is selected

Command + B (I) (U) Set to bold, italic, or underlined text (for system fonts)

Command + T Shows/Hides the full text formatting menu of fonts/sizes

Command + G Go Into Scroll Mode

Page Up / Page Down Scroll Document up/down one page

Command + Up Arrow Jump to top of script file

Command + Down Arrow Jump to end of script file

Home Key Jump to top of script file

End Key Jump to end of script file

Option + Tab Go To Next Paperclip in current document 

Option + Shift + Tab Go To Previous Paperclip in current document 

Command + [1..0]   Goto Bookmark 1 through 10
Command + Option + [1..0] Goto Bookmark 11 through 20
Command + Control + [1..0] Goto Bookmark 21 through 30

Command + Shift + B  Set new Bookmark with naming dialogue

Option + Command + Shift + B

 Set new Bookmark without prompting for the bookmark name. (The default name will 
be used automatically.)

Shortcuts while NOT scrolling, continued:



Sample Session

Boot MagicScroll 
and Open a File

If you’ve read this manual up to this point, then you should be famil-
iar with all of the commands, functions, and tools in MagicScroll. 
Now let’s put them together and run through a sample prompting ses-
sion step-by-step.

First, boot MagicScroll by double-clicking the MagicScroll icon from 
the finder.  You will see the Prompter Control panel.  Select New from 
the File menu to open a new “Untitled” window. You could start enter-
ing text in the new window, but let’s say that you’ve already done the 
script in another program and that you saved it as text in that pro-
gram.  Choose open from the File menu, navigate to the script you 
want and choose Open.

The new window will appear with the script in it. Now, if you like, 
reposition the Prompter Control window to a position on your screen 
that is most comfortable and out of the way of the script windows.

Next, since you opened a text file and not a MagicScroll file, you’ll 
probably need to change the font and size of the text to something 
that is readable by your talent on the output monitor.  Do this by hit-
ting the Command-T menu to bring up the font formatting window.  
Change font, size, other to a desired style.  

Now, if you have a little time before you have to prompt, you can do a 
little prep to help speed the production along.  First, proofread your 
script by scrolling it for yourself by entering scroll mode and view-
ing your text in the Preview window.  This way you’ll see how the text 
appears to the talent.  If a word is too long for the line and needs to 
be hyphenated, or if there is a typing error, you’ll be able to catch it 
before the talent does.  As you’re scrolling, you can use the paperclips 
by pressing the spacebar to mark places to come back to after reading 
through the script.  Next, go through and set some bookmarks that 
correspond to key parts of the script.  

Now you’re ready to roll.  Go to the start of your script, or another 
starting point.  Then click once on the MagicScroll Scroll icon and 
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Sample Prompting Session

Adjust your 
Windows

Select a Font 
and resize your 

script.

Do some script 
prep.
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start prompting.

When you’re done scrolling, if you’ve set your preferenc such that a 
mouse click exits scrolling, then click the mouse button again to exit 
scrolling.  You can also hit the ESC key to exit scrolling. 
You may want to customize the feel of MagicScroll at this point  by 
changing the position of the pointer by clicking on it and dragging it 
up or down.

You will almost certainly need to make changes to your script.  To do 
this, be sure that you are not scrolling.   Make your changes by select-
ing, deleting and typing text as necessary.  You may find it helpful to 
change to a smaller size font, which will allow you to see more of your 
script at a time.  This can be particularly helpful if you’re making many 
changes.  

After making your changes, be sure to Save your document.  If you have 
time, you may want to make a backup by choosing “Duplicate...”  You 
can quickly return to scrolling by clicking on the Scroll icon or typing 
Command-G.

Roll It!

Make quick 
changes.

Save your 
changes!
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Prompting Tips

This section is a collection of tips and suggestions for teleprompting 
in the field and studio.  These ideas cover everything from the setup 
to the wrap on a video production and don’t limit themselves to the 
use of MagicScroll.  We hope they’ll prove helpful in improving an 
operator’s production and teleprompting skills.

When “on location” check for the following;
 1) Try to get “clean” electrical power, ideally not on the same cir-
cuit as the lighting department.  (A blown circuit while in the middle 
of a “Save” could prove fatal to your document!)
 2) Determine a good place to set up the teleprompter.  Take into 
consideration the need for electrical power and the ability to see/hear 
talent.
 3) If you aren’t in the same room as talent, you’ll need to make 
arrangements with the sound department to get an audio feed.
 4) Find out where you can store extra cases and equipment so 
that they’ll be out of the way.
 By checking for these things early on, you can save time by 
avoiding last minute changes and surprises!

Introduce yourself or have someone introduce you to talent!  If you 
can’t do this in person, then you may want to do a quick screen/script 
that says “Hello, my name is so-and-so and I’m your friendly prompt-
er operator.”  Often times, this friendly introduction can help non-pro-
fessional talent relax when they realize that the prompter screen has a 
human element behind it.

Find out who will provide you with official script changes. Often 
times on larger productions, many people will attempt to suggest or 
make changes to scripts.  In these cases, determining whether it’s the 
producer, scriptwriter or talent who can designate a particular change 
is especially important.

Listening is one of the most important things an operator can do on 
a set. By paying close attention to conversations between the direc-
tor, producer, talent and other crew members, a good operator will 

Prompting tips for Operators

Tips for Location 
shooting.

Get introduced to 
talent.

Determine who 
makes script 

changes.

Listen!
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not only be ready to roll when the time comes, but will also be able to 
anticipate script changes, new starting points and other special needs 
as they arise.

When actually scrolling, the pace of the scroll should be set by the tal-
ent, not by the teleprompter operator. If possible, let talent know that 
he/she is setting the pace and that you are following their lead.

When scrolling, “lead” the talent a little bit. Instead of keeping the cur-
rent line that talent is speaking in the middle of the prompter screen, 
lead the talent a little bit by keeping the current line in the top 1/3 of 
the prompter screen. This way, talent can read ahead and anticipate 
what’s coming. Of course, everyone is different and you may find that 
some people like it even closer to the top of the screen or perhaps more 
towards the middle.

Help make the talent feel comfortable and relaxed by building trust. 
You can do this by scrolling accurately and smoothly, by listening and 
responding to prompter related requests/questions by talent, and by 
feeling comfortable and confident yourself.

Remember that MagicScroll can name bookmarks automatically 
based on the selected text when activating the “Set Bookmark” func-
tion   Conversely, if you don’t have any text selected when choosing “Set 
Bookmark”, it will automatically name it based on a previous name (if 
you’ve previously named the bookmark). 

In order to facilitate successful changes by someone looking over 
your shoulder or into the prompter monitor, quickly change to a 

smaller font size (18-24 point) that gives them the bigger 
picture of the script. You may even want to experiment 
with different fonts and sizes to see what looks better in 
the smaller format. 

Let talent set the 
pace.

Lead the talent a 
little bit. 

Build trust.

Use Automatic 
Naming of 

Bookmarks.
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Picture a friend or colleague behind the prompter mirror. You will be looking directly into 
the lens and will ‘connect’ with your audience.

Read the text from the middle of the screen.  If you like to read ahead, then read from the 
top 1/3 of the screen and let your prompter operator know that’s your preference.  Ask 
him/her to place the pointer at that place on the screen. The prompter operator will scroll 
the words on the screen as you read. His goal is to keep the line you are reading as close to 
the pointer as possible. The words will scroll by at whatever speed you read them. YOU are 
in control of the scroll speed.  If you have any doubts about this... try it by stopping and 
speeding up during a rehearsal.

Concentrate on your message, not the words.  Pause normally! Stop at periods.  Remember 
it’s all news to your audience. They don’t know you’ve rehearsed it over and over.

The goal is to make it look like you’re not reading.  To avoid PROMPTER PANIC, try blink-
ing occasionally, turning your head, ...smiling?... pretend you’re talking to real people...

The Director is your friend.  He will try to make your job as easy as possible.  When the 
Director says “Action”, take a deep breath to relax, wait one or two seconds, then begin.  
Until the Director stops you, YOU ARE IN CONTROL.

Singers know that your vocal cords are the first part of your body to dehydrate.  Therefore, 
drink lots of liquids.  You may find it helpful to have a glass of room-temperature water 
within arms reach.

Three more things.... RELAX... RELAX... RELAX....

Maintain your energy level until the Director says ‘CUT’.  When you finish speaking your 
piece you’ll probably want to look towards the director or camera person, but try to avoid 
this by continuing to look into the prompter.   This will allow the editors time to make his/
her cut.  

Don’t forget... this is supposed to be (and can be) FUN!!! 

Tips for Talent!
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Troubleshooting

If you’re having problems with the installation or operation of 
MagicScroll, be sure to review the relevant section of this manual. 
This section will attempt to locate common problems encountered by 
operators and engineers.  If you are unable to resolve your problem 
with this manual, then call Magic Teleprompting, Inc. at (415) 626-
5283 for support.

The macOS attempts to 
place a menu for your cur-
rent app in all windows for 
that app. To bypass this, 
you must go to System 
Preferences, Mission 
Control, and then ENABLE 
(turn the checkmark ON)
 the option that says 
“Displays have Separate Spaces”  You will need to log out and then 
back into your account to activate this.

In the MagicScroll prefer-
ences window, ENABLE the 
selection that says “Scroll 
Full Screen while no other 
monitors attached”

This may be happening 
because the “Script Loop” 
feature is on.  It may be looping between two bookmarks in your doc-
ument.  Check the placement of your bookmarks or turn the Loops 
feature off.

By design, Loops will not work  while Linking is on, and vice-versa.  
This functionality serves as a failsafe mechanism in case you forget to 
turn Loops Off while you’re in the middle of scrolling several scripts.

Troubleshooting

I’m seeing the menu at 
the top of my output 

monitor

Problem:

I’m trying to scroll full 
screen on my Mac, but 
only the preview win-

dow scrolls.

Problem:

The Script starts to 
jump around while 

scrolling. 

Problem:

Loops Function and 
Linking Function won’t 
work at the same time.

Problem:
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Glossary of terms

Alert box: Dialog box informing you of a problem, an incorrect value, or other condition where the 
application cannot proceed.

Application: Program that performs a specific task, such as graphics, accounting, or teleprompting. 
MagicScroll is an example of an application.

ASCII: American Standard Code for Information Interchange. A collection of 128 alphanumeric char-
acters and symbols whose internal computer representation is standardized. For example, the ASCII 
code for the letter “A” is 65 and the ASCII code for the letter “a” is 97.

Blackout: a stage term for turning off all stage and audience lighting in an auditorium.  The purpose 
is to darken the hall so as to show films or videos or for special effects.  Turning “Blanking” on in 
MagicScroll creates a Blackout to the prompter monitors.

Character: Single letter, numeral, punctuation mark, or symbol as part of a typeface.

Character Set: Set of letters, punctuation marks, and other symbols available in a particular typeface.

Clipboard: Area of memory (or disk) used as temporary storage to support cut, copy, and paste 
operations. See cut, copy, and paste.

Copy: Noun: Generic name for a publication’s text. Verb: Place the currently selected object onto the 
clipboard without removing it from the screen. See cut and paste.

Cut: Place the currently selected object onto the clipboard and remove it from the screen. See copy 
and paste.

Desk accessory: Utility program on the Macintosh. Examples of Macintosh desk accessories are the 
Calculator, Note Pad, Key Caps, and Chooser.

Desktop: Your working area on the Macintosh screen. This includes the menu bar and the gray area 
on the screen. The MagicScroll desktop appears on your screen when you open the MagicScroll appli-
cation.

Dialog box: Window that appears on a document window to provide command options, inform you 
of problems, and so on. In some cases, a dialog box has a title bar that allows you to move the box.

Directory: Pictorial, alphabetical, or chronological list of the contents of a folder or disk or a file that 
contains a list of all the names and locations of other files stored on a disk.

Document: File created with a Macintosh application. See file.

Document window: Window displaying a document. You can scroll up or down in a document win-

Glossary
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dow to display different parts of the document. You can have more than one document window open 
at a time, but only one document window can be active.

Drag: Move the mouse, with the button depressed, to move or select an object or to choose a menu 
option.

File: Organized, named collection of data. Although files can be stored in all types of memory, most 
references to files refer to files on floppy or hard disks. In Macintosh parlance, file is often used syn-
onymously with document.

Floppy disk: Removable magnetic storage medium for computers. Although Macintosh floppy disks 
have a hard plastic shell, the disks themselves are Mylar.

Folder: Macintosh subdirectory. A folder can contain documents (files), applications, and other fold-
ers. You can use Macintosh folders as you would use actual manila folders, to organize information in 
a way that is clear and useful to you. See hierarchical file system.

Font: Complete set of characters in one typeface, size, and style. In Macintosh parlance, font is often 
used synonymously with typeface.

Hard disk: High-capacity, magnetic storage system. Unlike floppy disks, hard disks are generally not 
removable. See floppy disk.

Hierarchical file system: (HFS) File organization system that lets you organize computer files and 
applications in nested subdirectories. On the Macintosh, folders, which are analogous to subdirecto-
ries, can be nested in other folders. See file and folder.

Icon: Graphic image that represents an object or concept. A screen icon in a mouse-based application 
may represent an object such as a document, disk, or application. Clicking that icon allows you to 
access it. An icon may also represent a concept, such as a wristwatch for “wait.”

Import documents: Use of the text of other Macintosh documents in MagicScroll using the Open... 
command.

Insertion point: Flashing line indicating where the characters you type will appear. The insertion 
point is moved by moving the mouse and clicking the I-beam pointer in a new location.
Justify: Set text with uniform left and right margins. To achieve this, extra space may be distributed 
between letters and/or words. Right justified and left justified refer to text aligned against the right 
and left margin, respectively.

Margin: Blank area from the edge of the page to the edge of the text (not including indents).

Memory: Computer hardware component used to store information for later retrieval. Memory is 
measured in number of bytes rounded to the nearest power of 2. Thus 65,536 bytes of memory is 
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abbreviated to 64K. (K is metric for 1,000.) See ROM and RAM.

Menu: List of options allowing you to choose the next action you want to take. See menu bar and 
menu title.

Menu bar: Horizontal bar at the top of the desktop containing menu titles. See menu bar and menu 
title.

Menu title: Name of a menu. Menu titles are listed horizontally on the menu bar on the desktop.

NTSC: Television video signal of 525 lines, 30 frames per second- the U.S. standard for television 
broadcast and playback.

Paperclip: In MagicScroll™, markers that can be placed at specific points in the script. They are auto-
matically numbered and can be accessed by cycling through them using the Command-Space keys. 

Paste: Place the contents of the clipboard on the active page of your document. You can paste text 
and objects. See cut and copy.

Point: Unit of measure of type size. 

Pointer: 1) Icon that moves around the screen when you move a mouse. Objects, tools, or commands 
can be selected with a pointer.
2) In MagicScroll™, a graphic reference point on the NTSC video screen and NTSC mini window that 
talent and operator can use to stay “in sync” while scrolling.

Program: List of instructions that a computer can execute. In Macintosh parlance, program is often 
used synonomously with application.

RAM: Random Access Memory. The active, working memory of the computer where your data, the 
current program, the operating system, and the screen image reside.

Real Estate: In computer lingo, the area on a computer screen for displaying the output of the com-
puter.  A larger screen will have more area to display elements of a program or operating system, 
while a smaller screen will have less.

RGB: Abbreviation of Red-Green-Blue. A method of displaying color on a video screen by transmit-
ting the three colors red, green, and blue as separate signals.

ROM: Abbreviation of Read Only Memory. A type of computer memory that retains its information 
when the power is off, and cannot be changed by the user.

Scroll: Move a document or directory in its window so that you can view another part of it. In 
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MagicScroll, to move the text of a script window forward or backwards using the MagicScroll slider.

Scroll bars: Vertical and horizontal bars on the right and bottom edges of the document window that 
allow you to view a document larger than the screen. By clicking or dragging on the scroll bar you can 
change your view of the document.

Selection: Noun: Object(s) or text selected by the user to be affected by the next command. Selections 
are usually highlighted or marked by outlines. Verb: Highlight text or click an object or group of 
objects.

Set: In film or video:  the area that is used for the videotaping or filming of a production. In stage: the 
scenery constructed for a theatrical performance.

Startup disk: Disk that contains a System Folder and the necessary files to start up the Macintosh.

System folder: Folder containing the System File and the Finder and often other applications and 
utilities. A disk should contain only one system folder.

Talent:  In a video or film production, the person who speaks and appears on camera.

Type style: Character modifications such as bold, italic, and so on.

Wrap:  1) Automatic continuation of text from one line to the next. making  it unnecessary to hit 
the Return key at the end of each line. 2) The end of a video or film shoot when the crew is finished 
shooting and puts away their equipment.  They can then go home, have dinner, go golfing or whatever 
they do when they’re not working.


